
 Habitat Protection Representation Tutorial 

Version 2.0 (ArcGIS) 
 

Background: (1) Coastal and marine habitats are vibrant ecologically and provide vital resources 

that sustain human populations. Numerous threats by climate change and human activities reduce 

the ability of the habitats to support biodiversity, ecosystem functions, and ecosystem services. 

Protected areas can allow those habitats to be more resilient and maintain key capacities, by saving 

species populations and crucial ecological interactions. Recently, a push globally for increased 

protection has occurred. Many questions remain on what and how much is protected. As a 

consequence, it is important to know what and where habitats have been protected currently. 

Purpose: Through this lesson, participants get an introduction to using fundamental and regularly 

used geospatial tools to analyze conservation situations. In particular, participants will integrate Allen 

Coral Atlas data with timely protection data in order to address conservation targets. By the end of 

this task, you will be able to calculate the percentage of the protected areas and determine if the 

protection goals are met. 

Objectives: (1) Learn about the Allen Coral Atlas benthic data, (2) Become familiarized with basic 

GIS analysis tools, (3) Understand how different freely available data sources can be combined to 

investigate conservation questions 

Technical requirements: Computer, GIS Software (ArcGIS), Internet 

Target audience: Beginner / Moderate GIS user 

Expected time for completion: 2 - 4 hours 

 

Before Beginning: 

● Within the "Level 2 Habitat Protection Tutorial" folder, are the following: 

○ A copy of this tutorial 

○ A folder called "gis_data"  

■ Geodatabase (tonga_habitat.gdb): contains required files for this tutorial (1) 

benthic data for central Tonga, (2) geomorphic data for central Tonga, (3) 

Tonga protected area data 

■ Four empty folders: (1) tonga_admin, (2) tonga_analysis, (3) 

tonga_ecological, (4) tonga_protection 

● ***Note: these will be where downloaded and produced folders will 

be saved 

● The hyperlinks in the steps direct you to a page with data or more information about the 

tool or process used. 

 

Considerations: 

● The Allen Coral Atlas provided the benthic and geomorphic data. Tonga protected areas 

were derived from the March 2020 update for the World Database on Protected Areas 

(WDPA) through Protected Planet 

https://allencoralatlas.org/
https://www.protectedplanet.net/
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● The Allen Coral Atlas benthic and geomorphic data when downloaded are in a geographic 

coordinate system: WGS84 

● For area calculations, the data should be in a projected coordinate system (e.g., Mollweide or 

UTM) 

○ ArcGIS = Project tool 

● The benthic and geomorphic data are being provided to you already in a projected 

coordinate system (i.e., Mollweide). This is due to the time required to project the Allen 

Coral Atlas benthic data to a new projection (~20 minutes). 

○ ***WARNING: The area of interest benthic and geomorphic data already have their 

areas calculated, but they are in square meters 

○ ***WARNING: It is not recommended to calculate geometry (which will be 

discussed further in the tutorial) in the hectares unit of measure for at least the 

benthic data, as it will take approximately 2 hours. An alternative is to use the "Field 

Calculator" and convert from square meters to hectares (square meters / 10000 = 

hectares) 

 

Additional comments: 

● If desired to recreate the central Tongan dataset or repeat for another area, the process is as 

follows: 

○ Download the EEZ layer for the area of interest (Maritime Boundaries v11) 

○ Load the data in GIS software 

○ ***Note: If multiple EEZs exist for the area of interest, run the required tool to make 

the single polygon feature into unique polygon features 

■ Multipart to Singlepart in ArcGIS 

○ Select the area of interest 

○ Export selected as new shapefile 

○ Load the benthic and geomorphic data 

■ ***Note: If the benthic and geomorphic data have not already been projected 

to a projected coordinate system do so 

■ ***Note: If an area field does not exist for the benthic or geomorphic data, it 

should be added (e.g., Add Geometry Attributes in ArcGIS); area fields 

should be in matching units (e.g., hectares, square kilometers, etc.) 

○ Clip the benthic and geomorphic data to the area of interest 

■ Clip in ArcGIS 

 

Phase 1: Obtaining data 

1. Tonga Land Boundary 

a. In the drop-down menu, select Tonga from the Global Database on Administrative 

Areas (GADM) 

 

https://desktop.arcgis.com/en/arcmap/latest/tools/data-management-toolbox/project.htm
http://www.marineregions.org/downloads.php
https://desktop.arcgis.com/en/arcmap/latest/tools/data-management-toolbox/multipart-to-singlepart.htm
https://desktop.arcgis.com/en/arcmap/latest/tools/data-management-toolbox/add-geometry-attributes.htm
https://desktop.arcgis.com/en/arcmap/10.3/tools/analysis-toolbox/clip.htm
https://gadm.org/download_country_v3.html
https://gadm.org/download_country_v3.html
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2. Click on the shapefile file format hyperlink and wait for the download. 

a. ***Note: Can read more about the available file formats for downloading here. 

3. Unzip the folder from the download location 

a. Default option will be using the "Extract All…" and then following the directions 

i. ***Recommendation: Download and install 7-Zip. It is free and provides greater 

options and faster compression and extractions. 

b. Rename data to a more identifiable name (e.g., tonga_land_wgs84 → 

location_description_coordinate system) 

i. Separate between the level 0 data and level 1 data 

ii. ***Note: Level 0 data are the data that will be used in the analysis 

iii. ***Note: Level 0 data are a single feature for the country, while Level 1 have 

five features for the five island groups (ʻEua, Haʻapai, Niuas, Tongatapu, and 

Vavaʻu) 

 
 

***Note: 7-Zip is a free download for quick data extraction 

This is the Windows, default option 

https://gadm.org/formats.html
https://www.7-zip.org/
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(1) Highlight all files with the 
name gadm36_TON_0 
(2) Right-click 
(3) Select the rename option 

When indicated, type in "tonga_land_wgs84" 
 
***Note: Make sure to only rename everything before the 
file type (.filetype). For example, as seen in the first file its 
new name is added, but the .cpg remains. This will 
maintain all the filetypes 
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4. Move the tonga_land_wgs84 files to the tonga_admin (i.e., administrative data for Tonga) 

folder in the gis folder 

a. ***Note: Make sure to copy all the associated files for the Tonga land layer (.cpg, 

.dbf, .prj, .shp., .shx)] 

b. ***Note: Can move the other data as well, but they are not required for this tutorial. 

 
 

 

As seen here, all files previously highlighted 
will have the name populated with the 
name, but maintain any part left unedited 
(i.e., the filetype) 
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5. Maritime 12 nautical mile boundary 

a. Under the Maritime Boundaries v11 section, select the shapefile option for the 12 

nautical miles dataset 

 
 

6. In the pop-up window, enter all the required information. 

a. Name 

b. Organization 

c. E-mail 

d. Country 

e. Reason for using these data 

f. Mark the "Agree to the disclaimer" 

g. Click "Download" 

 

http://www.marineregions.org/downloads.php
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7. Unzip the folder from the download location and move to the tonga_admin folder. 

a. ***Recommendation: rename the data to a more identifiable name (e.g., 

global_12nm_v11_wgs84) 

 

Phase 2: Checking data 

8. Open ArcGIS 

9. Add the GIS data (12nm, landmass, benthic, geomorphic, and protected area) 

a. The 12nm and land boundary data (level 0) are from the tonga_admin folder 

i. ***Note: Do not use the island group data if those data are in tonga_admin 

b. The benthic and protected area are in the provided in the tonga_habitat geodatabase 

c. Multiple ways to add data to the GIS software 

i. (1) File > Add Data > Add Data 

ii. (2) Add Data (from ribbon) 

iii. (3) directly through the ArcCatalog panel 

iv. (4) drag and drop with the .shp file from a folder on your computer [further 

ArcGIS guidance] 

 

 

Download will automatically 
start after clicking 
"Download" 

Make sure to check the "Agree" box 

https://desktop.arcgis.com/en/arcmap/10.3/map/working-with-layers/adding-layers-to-a-map.htm
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***Recommendation: Right now the plot view is at the globe level. This makes it difficult to see the 

data specific to Tonga. A quick change for the extent to match that of the Tonga central region is to 

right-click tonga_land_wgs84 and select the "Zoom to Layer." Now the data view should be 

zoomed and centered around Tonga. 

 

 
 

***Explore: Turn on and off the layers in the Layers panel by marking and unmarking the box next 

to the layer name in the Layer panel. 

 

Check-in 1: Are there any layers that do not appear even when they are turned on? If so, which 

ones? 

1 

2 

3 

***Clicking this symbol opens the Catalog 
panel 

***Navigate to the desired 
layer, then drag to the Table 
of Contents panel (or drop in 
this white space) 

Table of Contents 
Panel 

***The geodatabase data 
(benthic, geomorphic, and 
protected area) can be added in 
the same manners. 

Zoomed-in view Original view 
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10. Examine properties of the data 

a. Coordinate system 

i. Double left-click on the layer (or right-click and select "Properties"), navigate 

to "Source" and check the coordinate system 

1. ***Note: If using ArcGIS Pro, it will be the following [Properties > 

Source > Spatial Reference] 

 

 
 

 

Check-in 2: How many different coordinate systems are your data in? 

A. 1 

B. 2 

C. 4 

D. 5 

 

Phase 3: Preparing data 

11. Export the geodatabase data as their own layers to allow for data use (***Note: repeat for 

each layer) 

a. tonga_central_benthic_moll and tonga_central_geomorphic_moll should be 

exported to the tonga_ecological data 

b. tonga_wdpa_march2020 data should be located to the tonga_protection folder  

c. Right-click on data (e.g., tonga_central_benthic_moll) 

d. Data > Export data 

e. Browse to the tonga_ecological GIS folder 

f. Can maintain the same name (tonga_central_benthic_moll) or change it to 

something more preferred 

g. File type should be as a "Shapefile" 

h. Click "Save” 

Double left-click or 
right-click and select 
"Properties" 



Habitat Protection Representation Tutorial 

Allen Coral Atlas Page 10 of 31 

i. Click “OK” 

 

 
 

12. Match all the data into the same coordinate system 

a. Change the projection coordinate systems for the 12 nautical mile data, land data, 

and the WDPA data 

i. ArcGIS: Open the Project tool [is under the Data Management Tools > 

Projections and Transformations] 

1. Enter the input dataset (e.g., global_12nm_wgs84) 

2. Select the output destination to be the Tonga_admin folder, rename 

output file to designate that the new data are in the Mollweide 

coordinate system (e.g., global_12nm_moll) 

3. Select the icon to the right of the "Output Coordinate System" 

a. Type in Mollweide or 54009 into the filter 

i. ***Alternative: use the already existing layers if the 

benthic and geomorphic data are loaded 

ii. ***Alternative: navigate through the coordinate 

systems [Projected Coordinate System > World > 

Mollweide (world)] 

iii. ***Note: If typing "Mollweide" make sure to expand 

the folders for the Projected Coordinate Systems and 

find the Mollweide (world) option. 

This will keep the 
layer in the 
Mollweide system 

Can keep the same file name, but put 
the data into the tonga_ecological 
folder 

1 

2 
3 

4 

https://desktop.arcgis.com/en/arcmap/latest/tools/data-management-toolbox/project.htm
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13. If the projected data in Mollweide have not been added to the layers panel, add them 

a. ***Recommendation: to clean up the panel and reduce error, remove the data that were 

in WGS84 

i. This is done by right clicking the layer and selecting "Remove" 

b. Zoom to a data layer in the Mollweide coordinate system 

 

Data needing to change projection 
Output folder (e.g., tonga_protection) and new 
layer name (e.g., tonga_wdpa_0320_moll) 

Opens 1 

2 

3 

4 
Clicking this icon 
opens the "Spatial 
Reference Properties" 
window 

5 

6 

7 

Can search for 
Mollweide (or 50049) 
 
Also navigate in the 
Projected Coordinate 
Systems > World > 
Mollweide (world)  
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***Note: Repeat the process until all the layers are in Mollweide coordinate system. 

 

***Explore: Turn on and off all the Mollweide layers to see if all the layers appear in the data 

window. 

 

Check-in 3: How many layers have their coordinate reference system in Mollweide? 

 

14. Examine the 12 nautical boundary data to see which territories are included in the data  

a. Check the attribute table to notice that the data are global 

i. Right-click on the global_12nm_v11_moll data layer and select "Open 

Attribute Table" 

b. Alphabetize the Territory1 field to find Tonga 

i. Right-click on the Territory1 field and select "Sort Ascending" 
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Check-in 4: How many territories are included in the data? What is the ISO code for Tonga? 

 

15. Subset the nautical boundary to only have Tonga's 12nm data. 

a. Open properties > Definition Query tab > Query Builder… 

i. ***Recommendation: If you do not remember how to open properties review 

process from an earlier step. 

1. ***Hint: Coordinate systems are found within properties. 

ii. Can do this many different ways, but the easiest may be to use the 

"Territory1" field, as that is filled with the common English names for 

territories 

1. Double click "Territory1" to have it added to the expression box 

2. Click the equals (=) operator in the middle section 

3. With the "Territory1" field re-highlighted, select the "Get Unique 

Values" to have the box on the right be populated with territory 

names 

4. In the "Go To:" box, type 'Tonga' (apostrophe is required) 

5. Double click 'Tonga' to have it populate the expression box 

6. ***Note: the expression box should appear as "TERRITORY1" = 

'Tonga' (alternatively, can also type that expression directly into the 

expression box) 

7. Click "Verify" to check that there were no errors 

8. Click "OK" 

9. Click "Apply" 

10. Click "OK" 

 

Right-click on field "Territory1" 

https://desktop.arcgis.com/en/arcmap/10.3/map/working-with-layers/building-a-query-expression.htm
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Check-in 5: How many territories are shown in the attribute table? 

 

16. Export the Tonga 12nm boundary layer as its own data source to the tonga_admin folder 

a. Right-click on data 

b. Data > Export data 

c. Browse to the Tonga_admin GIS folder 

d. Rename to designate that these data are for Tonga (e.g., tonga_12nm_v11_moll) 

e. Save 

17. Add newly created data to canvas if they were not already added and remove the global 

12nm boundary data 

18. Zoom to the entire Tonga 12nm data 

 

Check-in 6: How many polygons appear to comprise the Tongan 12nm boundary? 

 

19. May look like there are multiple polygons, but the data are a single feature (see attribute 

table). To get each polygon to be its own feature, the data need to be split 

a. ***Note: This will have the data create unique features for every separated polygon 

b. Use the Multipart to Singlepart (Data Management Tools > Features)  

i. Input feature = Tonga 12nm data (in Mollweide) 

ii. Output feature class = new layer (e.g., tonga_12nm_v11_single_moll) 

 

 

1 

2 

3 

4 

5 

6 

7 
8 

9 

10 

Double-click this field 
 
Need to have selected for 5 to 
work 

This area will be dynamically 
populating as you click the 
field, operators, and data 
 
Can also type this line 

This will dynamically 
change as more 
characters are added 
in the "Go To:" box 

 

This area will be blank till you hit okay at 8. 
 
Or can type this line into this box and jump 
to 9 

https://desktop.arcgis.com/en/arcmap/latest/tools/data-management-toolbox/multipart-to-singlepart.htm
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1. Place in the tonga_admin folder 

c. If the data were not added to the "Layers" panel, add them 

 

 
 

Check-in 7: How many features are in the singlepart version of the Tonga 12nm boundary layer? 

How does that number compare to the number for the last check-in? 

 

20. Boundaries around islands are for all islands, but benthic and geomorphic data are only in 

the centralized system. To obtain only the 12nm boundaries that have benthic and 

geomorphic data, run a selection by location. 

a. Use the Select Layer by Location (Data Management > Layers and Table Views)  

i. Select Layer by Location (Process 1) 

1. Input features: Tonga 12 nautical miles single features 

2. Overlap type: Contains 

a. ***Note: For graphic examples of relationships 

3. Selecting features: Tonga central geomorphic data 

a. ***Note: can use the benthic data, but it will run slower since 

there are more features in those data to search through 

4. Selection type: New selection 

5. Click "OK" 

b. Alternative: Use the "Selection" in the ribbon and choose the "Select By Location..." 

i. Select by Location (Process 2) 

1. Selection method: "select features from" 

2. Target layer(s): Tonga 12nm single features data 

3. Source layer: Tonga geomorphic data 

https://desktop.arcgis.com/en/arcmap/latest/tools/data-management-toolbox/select-layer-by-location.htm
https://desktop.arcgis.com/en/arcmap/latest/tools/data-management-toolbox/select-by-location-graphical-examples.htm
https://desktop.arcgis.com/en/arcmap/10.3/map/working-with-layers/using-select-by-location.htm
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4. Spatial selection: "contain the source layer feature" 

a. ***Note: For graphic examples of relationships 

 

 
 

21. Export selected features as new layer (if that has not already occurred) 

a. Save with name that indicates these data are for the central region (e.g., 

tonga_12nm_v11_single_central_moll) 

 

Check-in 8: What percent of the 12nm boundary features have benthic data? 

 

22. Obtain only protected areas that are coastal and marine using the "Query Builder" function 

again, but on the tonga_wdpa_march2020_moll layer this time 

a. ***Note: reference the previous use of "Query Builder" to remember how to access 

the functionality 

b. In this case, the query should select all the coastal and marine protected areas using 

the data's "Marine" field  

i. 1 = coastal area 

ii. 2 = fully marine 

c. Perhaps an easier way to do it, however, is to select everything that is not those. 

i. 0 = land 

d. The "<>" means "not equal to", so "Marine" <> '0' is the equivalent of saying: 

"select all of the WDPA data that are not equal to 0". 

i. ***Recommendation: If worried about creating errors, pick the field name and 

operator from the options rather than typing it, and use the ‘Get Unique 

Values’ button to select 0. 

Process 2 

Process 1 

https://desktop.arcgis.com/en/arcmap/latest/tools/data-management-toolbox/select-by-location-graphical-examples.htm
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ii. ***Recommendation: For what each SQL operator does 

e. ***Note: further detail in Table 3.1 (page 16) in WDPA manual 

 

 
 

23. Export the WDPA data as a new layer (e.g., tonga_WDPA_marine_moll) in the protection 

folder 

24. Select by location the WDPA data that overlap the Tonga central region to generate a new 

layer (i.e., where the benthic data are located within). 

 

Check-in 9: How many coastal and marine protected areas are in the central region for Tonga? 

 

Phase 3: Creating data 

***Note: For simplicity the marine and coastal protected areas (layer with 38 features) will be 

referenced as just marine WDPA in the steps. 

 

25. Extract the benthic data located in coastal/marine protected areas 

a. Clip (Analysis > Extract) 

i. Input data: central Tonga benthic data 

ii. Clip feature: marine WDPA data for the central Tongan region 

No need to use 
the "Go To:" 
box as only 
three options 
exist 

This will autopopulate 
moving through steps 2 - 4 

This will populate 
once 6 occurs 

1 

2 

3 
4 

5 

6 
7 

8 

https://www.w3schools.com/sql/sql_operators.asp
https://www.protectedplanet.net/system/comfy/cms/files/files/000/000/203/original/WDPA_WDOECM_Manual_1_6.pdf
https://desktop.arcgis.com/en/arcmap/latest/tools/analysis-toolbox/clip.htm
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iii. Save in the ecological folder with a name detailing the data (e.g., 

tonga_wdpa_central_benthic_moll or 

tonga_wdpa_central_geomorphic_moll) 

 

 
 

26. Run a spatial join to get which protected area is associated with each unique benthic class 

area 

a. Spatial Join (Analysis > Overlay) 

i. Target features: clipped benthic data in the marine WDPA areas 

ii. Join features: central Tonga marine WDPA 

iii. Join operation: Join one to many 

iv. Save in the ecological folder with a clear name (e.g., 

tonga_central_benthic_wdpa_join_moll) 

 

https://desktop.arcgis.com/en/arcmap/latest/tools/analysis-toolbox/spatial-join.htm
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27. Consolidating the data to have the benthic categories each protected area will rely on the 

dissolve tool 

a. Dissolve (Data Management Tools > Generalization) 

i. Input features: joined benthic and protected area data for the central Tonga 

region 

ii. Dissolve Fields: Dissolve the data using the benthic class [Benth_Comp] and 

protected area name [NAME] 

1. Mark both fields and leave all others unmarked 

2. ***Note: For geomorphic data, the field will be [Geo_Zone] 

iii. Statistics Field: Field = Shape_Area, statistic type = sum 

1. ***Note: Shape_Area in this case is the area for the benthic area, 

while all the other area fields are related to the protected areas (e.g., 

REP_M_Area, GIS_M_Area, Rep_Area, NO_TK_Area, and 

Shape_Ar_1) 

2. In effect, this will calculate the total area of each benthic habitat that 

occurs in each protected area 

iv. Mark the option to "Create multipart features" 

1. This will make sure that all the Coral/Algae areas for a particular 

protected area are summarized into one line 

v. Save the data in the ecological folder with a name that is clear (e.g., 

tonga_central_benthic_wdpa_join_dissolve_multi_moll) 

 

https://desktop.arcgis.com/en/arcmap/latest/tools/data-management-toolbox/dissolve.htm
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28. Calculate the cover extent of each protected area’s benthic category in hectares 

a. ***Note: Areas should be no larger than 795, if the areas are in the tens of thousands 

or greater, then the area needs to be recalculated. 

b. Open the Attribute Table 

c. Right-click on field “Sum_Shape_” 

d. Select "Calculate Geometry" 

e. Property = Area 

f. Units = Hectares [ha] 

 

Benth_Comp and NAME 
should be the only ones marked 

Shape_Area is for benthic 
classes, not the protected areas 
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Check-in 10: What are the top five protected areas for maximum protection of seagrass? 

 

29. Dive into the data specifically for Mango Island 

a. Option 1: "Select by Attributes" where NAME = Mango Island 

i. ***Note: will highlight the features for Mango Island 

b. Option 2: “Select” (Analysis > Extract) where NAME = Mango Island 

i. ***Note: will generate a new layer of only Mango Island features 

c. Option 2: Create a "Query Builder" where NAME = Mango Island 

i. ***Note: will filter the Mango Island features within the initial data layer 

d. Option 3: Select from the Attribute Table manually 

i. ***Note: will highlight the features for Mango Island 

e. Export the data (either selected data or queried data) to the analysis folder 

 

https://desktop.arcgis.com/en/arcmap/latest/map/working-with-layers/using-select-by-attributes.htm
https://desktop.arcgis.com/en/arcmap/latest/tools/analysis-toolbox/select.htm
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Check-in 11: Rank the benthic classes from least to most area for Mango Island? How much 

coral/algae is protected? 

 

30. Clear the selection (  in the ribbon) or delete the definition query from the dissolved 

joined protected benthic data with protected area names so that all the features are seen in 

the attribute table 

a. ***Note: Layer's attribute table should once again show 251 features 

 

Phase 4: Data analysis 

31. Calculate the benthic types across all the protected areas 

a. From the spatially joined dissolved data, run another dissolve but only using the 

benthic class [Benth_Comp] 

i. ***Note: can use the original joined data, but will likely take longer since there 

are more features 

ii. ***Note: For geomorphic data, the field will be [Geo_Zone] 

b. Sum the total area of each benthic category 

i. ***Note: May need to recalculate the area field 

c. Save data in the ecological folder (e.g., tonga_central_benthic_protected_moll) 

 

2 

1 

Highlight the rows with 
Mango Island 

3 

4 
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32. Prepare the central regional benthic class area to compare to the protected area data 

a. Dissolve the original Tonga central benthic data based on the benthic class 

b. Recalculate the area to make sure they are in hectares 

i. ***Note: As mentioned in the beginning of the tutorial, the central benthic 

data from the geodatabase are in square meters. To compare to the protected 

area data, the data need to be in hectares 

ii. ***Note: if problems occur with “Calculate Geometry” convert square 

kilometers to hectares within the area field (“Sum_Shape_”) 

1. Open the attribute table 

2. Open "Field Calculator" 

a. Right-click on the area field and select the "Field Calculator" 

3. Add the area field from "Fields" 

4. Click on "/" [divider] 

5. Click into the expression box and type "10000" 

6. ***Alternative: type "Shape_Area / 10000" into the expression box 
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Checkin-in 12: Which three benthic classes have greater than 10000 hectares in the central Tonga 

region? 

 

33. Join the dissolved protected area benthic data to the dissolved central region benthic class 

data 

a. Right-click on dissolved central Tonga benthic data 

b. Select the Join and Relates > Join 

c. Field (1): Benth_Comp 

d. Other table (2): Tonga protected benthic 

e. Field for join (3): Benth_Comp 

f. ***Note: check to keep all protected areas; though all benthic classes should be 

present in both datasets to match 

g. Export the joined layer as a new layer in the tonga_analysis folder (e.g., 

tonga_central_region_protected_benthic_join_moll)  

h. ***Alternative: use the Add Join Tool (Data Management > Joins) 

i. The output folder should be tonga_analysis with a descriptive filename (e.g., 

tonga_region_protected_benthic_join_moll) 

ii. ***Note: Join Field (Data Management > Joins) is for when field names are 

not the same (i.e., Benth_Comp and Benth_Comp1) 

 

Hectare values 

Square meter values 

https://desktop.arcgis.com/en/arcmap/latest/manage-data/tables/essentials-of-joining-tables.htm
https://desktop.arcgis.com/en/arcmap/latest/tools/data-management-toolbox/add-join.htm
https://desktop.arcgis.com/en/arcmap/latest/tools/data-management-toolbox/join-field.htm
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34. Clean up the data to have only benthic categories and the areas for the central region and 

protected areas 

a. Open Delete Field (Data Management Tools > Fields) 

b. Select all the fields not the benthic category and summed areas 

c. ***Alternative: Open Attribute table and right-click on field and select the delete field 

option 

 

Join the table with the 
dissolved protected 
benthic class data 

https://desktop.arcgis.com/en/arcmap/latest/tools/data-management-toolbox/delete-field.htm
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35. Create a new field to populate with percent each benthic class is protected 

a. Open Attribute Table, select Add Field from drop down and type in the key 

information 

b. ***Alternative: Add Field (Data Management Tools > Fields) 

i. Input Table = Tonga region and protected benthic data 

ii. Field Name = Percent 

iii. Field Type = Float (more information on the different types) 

iv. Field Precision = 6 

v. Field Scale = 2 

 

 

Process 2 

Process 1 

https://desktop.arcgis.com/en/arcmap/latest/tools/data-management-toolbox/add-field.htm
https://desktop.arcgis.com/en/arcmap/latest/manage-data/geodatabases/arcgis-field-data-types.htm
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36. Rename fields to make them clearer 

a. In the attribute table open the properties for the first "Benth_Comp" by right 

clicking on it and selecting "Properties" 

b. ***Alternative: Double click on the layer, navigate to Fields tab, and change "Alias" 

per each field 

c. Change "Alias"for the fields 

i. Benthic and area fields for the region could become “Central” and “Central 

Ar” 

ii. Benthic and area fields for the protected areas could become “Protect” and 

“Protect Ar” 

 

Properties icon 
is located here 
in the attribute 
table 

 

Process 2 

Process 1 
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37. Calculate the percent of each benthic habitat protected 

a. Right-click on "Percent" column in Attribute Table 

b. Select "Field Calculator" 

c. Double click on field that is the protected benthic area 

i. ***Note: the original name will be shown, not the newly created alias 

d. Press the "/" operator [divider] 

e. Double click on the field representing the region benthic area 

i. ***Note: the original name will be shown, not the newly created alias 

f. Select the "*" operator [multiplier] 

g. Type 100 

h. Should see: "SUM_SUM_Sh" / "SUM_Shape" * 100 

i. Could also add () around the division to ensure readability 

ii. Could also type ("Protected Benthic Area" / "Region Benthic Area") * 100 

i. ***Alternative: Calculate Field (Data Management Tools > Fields) 

 

Process 1 

Process 2 

https://desktop.arcgis.com/en/arcmap/latest/tools/data-management-toolbox/calculate-field.htm


Habitat Protection Representation Tutorial 

Page 29 of 31 Allen Coral Atlas 

 
 

Check-in 13: If Tonga was aiming to protect 20% of its coral reefs, has it achieved this goal in the 

central region using the coral/algae class? How about for seagrass? 

 

38. Calculating the contribution of each benthic class amongst the total of the all the protected 

areas requires a new field. 

a. Call the new field ProtPerc (Protected Percent) 

b. Similarly this will be a float field (as numbers will be entered to it) 

c. Calculate the sum of the benthic protection area column 

i. Right-click on field 

ii. Select "Statistics" 

iii. Copy the sum total 

d. Calculate the percent of each benthic class from the protected total 

e. Verify that the percentages add up to 100 by calculating the sum again in the 

"ProtPerc" field 

 

Check-in 14: What is the total hectarage of the 7 benthic classes that are protected? 

 

SUM_SUM_Sh = Protected 
Area 
 
SUM_Shape = Central Area 
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Recap 

Upon reaching the end of this tutorial, you have successfully created and modified approximately 20 

data layers and are able to answer numerous questions that would be helpful for resource managers 

on benthic habitat and protected habitat. Aggregating and disaggregating the data in different ways 

can now answer: 

(1) How much of each benthic class is in the central Tongan region? 

(2) Which protected areas provide protection to benthic classes? 

(3) How much of each benthic class are in the protected areas? 

(4) What is the percentage of protected benthic classes within the central Tongan region? 

(5) What are the percentages of each benthic class in each protected area? 

 

Continuations 

This tutorial focused on the Allen Coral Atlas benthic class data. Geomorphic zone data, provided 

by the Allen Coral Atlas, could provide insights on propagation for the benthic habitats--natural or 

even artificial reseeding efforts. Thus, running these analyses again substituting the geomorphic zone 

data in place of the benthic habitat data would assist in identifying areas that meet keep thresholds to 

target for restoration and protection efforts. 

 

Allen Coral Atlas data can aid managers in adapting marine spatial planning to fulfill protection 

targets outlined by the Aichi Target 11 or another national target. You can investigate how much 

benthic habitat would be newly protected if protected areas were extended by a fixed distance, such 

Protected area / summed total 
protected area * 100 
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as 1 kilometer. Alternatively, the benthic class areas that are not protected could be examined to see 

if a new protected area should be enacted or an existing one could be extended. 

 

Hint to answer these questions, the "Erase" tool produces all data that fall outside of an area of 

interest (e.g., protected areas / buffered protected areas) will be the most helpful way to complete 

those data. 

 

A common fifth phase of working with spatial data is constructing a map to share with key partners. 

These maps will be nice visualizations for others to see and understand the spatial relationships of 

benthic classes in the region and protected areas. Can create a map using the data generated and add 

map elements by selecting a new print layout. Check out this overview to see how ArcGIS can make 

a visualization for this project and any more you may pursue with the Allen Coral Atlas data! 

https://desktop.arcgis.com/en/arcmap/10.3/tools/analysis-toolbox/erase.htm
https://desktop.arcgis.com/en/arcmap/latest/map/page-layouts/a-quick-tour-of-page-layouts.htm

